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Advanced Configuration on Mac OS 9.x

This chapter describes the advanced configuration options of the Cisco Aironet Wireless Client Utility 
running on the Mac OS 9.x operating system.

The following topics are covered in this chapter:

• Using the Client Utility on Mac OS 9.x, page 5-2

• Getting Started, page 5-2

• Loading New Firmware, page 5-5

• Configuring Your Client Adapter, page 5-7

• Turning Your Client Adapter Radio On or Off, page 5-26

• Obtaining System Address and Software Version Information, page 5-27
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Using the Client Utility on Mac OS 9.x
Using the Client Utility on Mac OS 9.x
This section explains how to use pcm3x0PPC, the Mac OS 9.x client utility, to load new firmware, and 
to configure your client adapter for use in a wireless enterprise or home network. You can set parameters 
that prepare the adapter for network use, govern how the adapter transmits or receives data, and controls 
the adapter’s operation within an infrastructure or ad hoc network.

Getting Started
To open the pcm3x0PPC client utility, follow the steps below.

Step 1 Double-click the Macintosh hard disk icon on the desktop.

Step 2 Double-click the Cisco pcm3x0 folder icon.

Note If you selected a location other than the default (the Cisco pcm3x0 Folder) during the installation 
process, select the folder in which you directed the utility to be installed.

Step 3 Double-click the pcm3x0PPC icon. The computer searches for the client adapter. After the adapter is 
found, the Basic Properties screen appears (see Figure 5-1).

Figure 5-1 Basic Properties Screen

The Basic Properties screen provides useful information about your client adapter, enables you to set a 
few key configuration parameters initially, and serves as a quick configuration menu for later use. This 
screen reflects the information and parameters for either an office network or a home network, depending 
on which one is set in the System Parameters screen (see Figure 5-6 on page 5-8). Office network is the 
default value.
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Getting Started
The Basic Properties screen displays the following information:

• Status—The operational mode of your client adapter. If your client adapter is associated to an 
access point, the name and IP address of the access point are also displayed, if this information is 
available.

– Error retrieving status—Your client adapter experienced a communication error.

– Card associated—Your client adapter is associated to an access point.

– Card not associated—Your client adapter is ready and enabled but not associated to an 
access point.

– Card not enabled—Your client adapter is ready but not enabled.

– Card not configured—Your client adapter is not ready and not enabled.

• Radio Status—Indicates whether your client adapter’s radio is on or off. You can click the Turn 
Radio On/Off button to turn the radio on or off.

• Radio ID—The MAC address of your client adapter.

• Signal Level—The strength of your client adapter’s radio signal (Range: 0 to 100%).

• Base Station ID—The MAC address of the access point or base station to which your client adapter 
is associated.

Table 5-1 lists and describes the parameters that can be set from the Basic Properties screen. Follow the 
instructions in the table to initially set or change any parameters.

Table 5-1 Basic Properties Parameters  

Parameter Description

Network Specifies the type of network in which your client adapter is installed.

Default: Computer to Base Station

Network Type Description

Computer to Computer Also referred to as ad hoc or peer to peer. 
Used to set up a small network between two 
or more devices. For example, an ad hoc 
network could be set up between computers in 
a conference room so users can share 
information in a meeting.

Computer to Base Station Also referred to as infrastructure. Used to set 
up a connection to a wired Ethernet network 
(through an access point or base station).

SSID The service set identifier (SSID) identifies the wireless network that you 
want to access.

Range: Up to 32 characters (case sensitive)

Note If you leave this parameter blank, your client adapter can associate 
to any access point on the network that is configured to allow 
broadcast SSIDs (see the AP Radio Hardware page in the access 
point Management System). If the access points with which you wish 
to communicate are not configured to allow broadcast SSIDs, the 
value of this parameter must match the SSID of the access points. 
Otherwise, you will not be able to access the network.
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Getting Started
Step 4 The menu bar (see Figure 5-2) in the top left-hand corner of the desktop allows you to choose menu 
options that you can use to configure and diagnose your client adapter.

Figure 5-2 Menu Bar

Enable WEP Enables or disables Wired Equivalent Privacy (WEP) for your client adapter.

• If you want to enable WEP for your client adapter, you must select this 
check box and create a WEP key. Refer to Chapter 4, “Security 
Features” for more information on WEP and instructions on setting a 
WEP key.

Note This check box can also be used to disable or enable WEP after it is 
enabled.

• If you enable LEAP for your client adapter, this check box is selected 
automatically.

Default: Deselected

Enable LEAP Enables or disables LEAP (also referred to as EAP - Cisco Wireless) for your 
client adapter.

If you want to enable LEAP for your client adapter, you must select this 
check box and set a username and password. Refer to the “LEAP” section on 
page 4-17 for more information about LEAP and instructions on setting a 
LEAP username and password.

Note This check box can also be used to disable or enable LEAP after it is 
enabled.

Default: Deselected

Table 5-1 Basic Properties Parameters (continued) 

Parameter Description
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Loading New Firmware
Your client adapter’s firmware is contained in the adapter’s Flash memory, which allows it to be easily 
updated in the future. The current version of your adapter’s firmware is provided in the Status screen. 
See the “Viewing the Current Status of Your Client Adapter” section on page 7-2 for instructions on 
accessing this screen.

You can find the latest firmware version for your client adapter at the Cisco Software Center web site. 
Follow the instructions below to obtain and load the new firmware into your client adapter:

Note If a power failure occurs while you are loading new firmware, your client adapter can become 
inoperable. If this occurs, start the procedure again. 

Step 1 To obtain the latest client adapter radio firmware from the Cisco web site, follow these steps:

a. Use your web browser to access the Cisco Software Center at the following URL:

http://www.cisco.com/public/sw-center/sw-wireless.shtml

b. In the firmware section, click on the link for your client adapter’s series, such as Cisco Aironet 350 
Series.

c. Click on the latest radio firmware filename for your client adapter, such as PC350v42523.exe.

Note The firmware image file (*.exe) is a compressed file. You can use Stuffit Expander to expand 
(uncompress) this file.

Note To support the message integrity check (MIC) feature, you must use firmware version 4.25.23 
or later.

d. Read and accept the terms and conditions of the Software License Agreement.

e. Select the Cisco server from which to download the file.

f. Save the file to your hard drive then exit the web browser. 

Step 2 Locate and use the Stuffit Expander program on your hard drive to expand (uncompress) the radio 
firmware image file you copied to your hard drive. This creates an image file (filename.img) in the folder 
where the compressed file is located.

Step 3 Make sure the client adapter is installed in your computer and is operational.
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Loading New Firmware
Step 4 Select Load Firmware from the Edit pull-down menu (see Figure 5-3). The Firmware window appears 
(see Figure 5-4).

Figure 5-3 Edit Pull-Down Menu

Figure 5-4 Firmware Window

Step 5 Under Name, select the location of the new firmware (for example, Macintosh HD).

Step 6 Click the new firmware image file (*.img).

Step 7 Click the Open button. A dialog box appears indicating the progress of the download. The selected 
image is loaded into the client adapter’s Flash memory.

Step 8 When the Firmware download successful message appears, click OK. 
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Configuring Your Client Adapter
The pcm3x0PPC client utility enables you to change the configuration parameters of your client adapter. 
The adapter’s parameters are organized into two main categories depending on your network’s 
configuration:

• Enterprise parameters—Use these parameters to configure your client adapter for use in an 
enterprise network, such as that found in a large organization:

– System parameters—Prepare the client adapter for use in a wireless network

– RF network parameters—Control how the client adapter transmits and receives data

– Advanced infrastructure parameters—Control how the client adapter operates within an 
infrastructure network

– Advanced ad hoc parameters—Control how the client adapter operates within an ad hoc 
(peer-to-peer) network

• Home networking parameters—Use these parameters to prepare your client adapter to operate in 
a home network.

Note Despite their name, the home networking parameters are not limited to use in a home 
network. For instance, these parameters, which are confined to one screen, provide a 
convenient way to minimally configure the client adapter.

Table 5-2 enables you to quickly locate the instructions for modifying the client adapter’s parameters.

Table 5-2 Locating Configuration Instructions

Parameter Category Page Number

Enterprise 5-8

System 5-8

RF network 5-12

Advanced infrastructure 5-16

Advanced ad hoc 5-19

Home networking 5-22
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Configuring Your Client Adapter
Setting Enterprise Parameters
The parameters in this section can be used to configure your client adapter for use in an enterprise 
network. If you are planning to use your client adapter in a home network, go to the “Setting Home 
Networking Parameters” section on page 5-22.

Setting System Parameters

The System Parameters screen (see Figure 5-6) enables you to set parameters that prepare the client 
adapter for use in a wireless network. To access this screen, select Edit Properties from the File 
pull-down menu (see Figure 5-5) and click the System Parameters tab.

Note The Basic Properties screen and the Edit Properties screen cannot be open at the same time. Use the 
Close option from the File menu (see Figure 5-5) or click the square Close button in the top left-hand 
corner to close the screen.

Figure 5-5 File Pull-Down Menu

Figure 5-6 System Parameters Screen

Table 5-3 lists and describes the client adapter’s system parameters. Follow the instructions in the table 
to initially set or change any parameters.
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Configuring Your Client Adapter
Table 5-3 System Parameters  

Parameter Description

Client Name A logical name for your workstation. It enables an administrator to determine 
which devices are connected to the access point without having to memorize 
every MAC address. This name is included in the access point’s list of 
connected devices.

Range: Up to 16 characters

Note Each computer on the network should have a unique client name.

SSID1 The service set identifier (SSID) identifies the specific wireless network that 
you want to access.

Range: Up to 32 characters (case sensitive)

Note If you leave this parameter blank, your client adapter can associate to 
any access point on the network that is configured to allow broadcast 
SSIDs (see the AP Radio Hardware page in the Access Point 
Management System). If the access points with which you wish to 
communicate are not configured to allow broadcast SSIDs, the value 
of this parameter must match the SSID of the access points. 
Otherwise, you cannot access the network.

SSID2 An optional SSID that identifies a second distinct network and enables you to 
roam to that network without having to reconfigure your client adapter. See 
the note below.

Range: Up to 32 characters (case sensitive)

SSID3 An optional SSID that identifies a third distinct network and enables you to 
roam to that network without having to reconfigure your client adapter. See 
the note below.

Range: Up to 32 characters (case sensitive)

Note If your client adapter’s firmware version is below 4.04, your optional SSIDs, 
which are set by the SSID2 and SSID3 parameters, are effective only for access 
points that are configured to allow broadcast SSIDs (see the AP Radio Hardware 
page in the Access Point Management System). To take full advantage of the 
optional SSID feature, upgrade your firmware to version 4.04 or higher.
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Power Save Mode Sets your client adapter to its optimum power consumption setting.

Default: Constant Awake Mode (CAM)

Power Save Mode Description

Constant Awake Mode Keeps the client adapter powered up continuously 
so there is little lag in message response time.

Consumes the most power but offers the highest 
throughput. Is recommended for desktop 
computers and devices that use AC power.

Fast Power Save Mode Switches between a PSP mode and CAM mode, 
depending on network traffic. This mode switches 
to CAM when retrieving a large number of 
packets and switches back to PSP after the packets 
are retrieved.

Is recommended when power consumption is a 
concern but you need greater throughput than that 
allowed by Max PSP.

Maximum Power
Save Mode

Causes the access point to buffer incoming 
messages for the client adapter, which wakes up 
periodically and polls the access point to see if 
any buffered messages are waiting for it. The 
adapter can request each message and then go 
back to sleep.

Conserves the most power but offers the lowest 
throughput. Is recommended for devices for 
which power consumption is the ultimate concern 
(such as small battery-powered devices).

Table 5-3 System Parameters (continued) 

Parameter Description
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Configuring Your Client Adapter
Click Apply at the bottom of the System Parameters screen to save any changes you have made.

Network Type Specifies the type of network in which your client adapter is installed.

Default: Infrastructure Mode

Network Type Description

Ad Hoc Mode Often referred to as peer to peer. Used to set up a 
small network between two or more devices. For 
example, an ad hoc network could be set up 
between computers in a conference room so users 
can share information in a meeting.

Infrastructure Mode Used to set up a connection to a wired Ethernet 
network (through an access point).

Network Specifies the network configuration in which your client adapter is used.

Default: Office Network

Note Select Office Network if your client adapter will be used in an 
enterprise network. If you are planning to use your client adapter in a 
home network, go to the “Setting Home Networking Parameters” 
section on page 5-22.

Table 5-3 System Parameters (continued) 

Parameter Description
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Configuring Your Client Adapter
Setting RF Network Parameters

The RF Network Parameters screen (see Figure 5-7) enables you to set parameters that control how and 
when the client adapter transmits and receives data. To access this screen, select Edit Properties from 
the File pull-down menu (see Figure 5-5 on page 5-8) and click the RF Network Parameters tab.

Figure 5-7 RF Network Parameters Screen

Table 5-4 lists and describes the client adapter’s RF network parameters. Follow the instructions in the 
table to initially set or change any parameters.

Table 5-4 RF Network Parameters

Parameter Description

Fragment Threshold Defines the threshold above which an RF data packet is split up or 
fragmented. If one of those fragmented packets experiences interference 
during transmission, only that specific packet would need to be resent. 

Throughput is generally lower for fragmented packets because the fixed 
packet overhead consumes a higher portion of the RF bandwidth.

Range: 256 to 2312

Default: 2312

Data Retries Defines the number of times a packet is resent if the initial transmission is 
unsuccessful.

Range: 1 to 128

Default: 16

Note If your network protocol performs its own retries, set this to a 
smaller value than the default. This way notification of a “bad” 
packet will be sent up the protocol stack quickly so the application 
can retransmit the packet if necessary.
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Authentication Type Defines how your client adapter will attempt to authenticate to an access 
point.

Default: Open

Authentication Description

Open Allows your client adapter, regardless of its WEP 
settings, to authenticate and attempt to 
communicate with an access point.

Shared Key Allows your client adapter to communicate only 
with access points that have the same WEP keys.

The access point sends a known unencrypted 
“challenge packet” to the client adapter, which 
encrypts the packet and sends it back to the access 
point. The access point attempts to decrypt the 
encrypted packet and sends an authentication 
response packet indicating the success or failure of 
the decryption back to the client adapter.

Note If LEAP is enabled on your client adapter, Open is the only available option. 

Note The Shared Key option is available only if the client adapter has been assigned a WEP key and 
WEP is enabled. Refer to the Chapter 4, “Security Features” for instructions on setting a WEP 
key and enabling WEP.

Data Rate Specifies the rate at which you want your client adapter to transmit or 
receive packets to or from access points (in infrastructure mode) or other 
clients (in ad hoc mode).

The data rate must be auto or the same as the wireless device with which you 
wish to communicate.

Default: Auto

Data Rate Description

Auto Uses the 11-Mbps data rate when possible but drops 
to lower rates when necessary.

1 Mbps Offers the greatest range but the lowest throughput.

2 Mbps Offers less range but greater throughput than the 1 
Mbps Only option.

5.5 Mbps Offers less range but greater throughput than the 2 
Mbps Only option.

11 Mbps Offers the greatest throughput but the lowest range.

Table 5-4 RF Network Parameters (continued)

Parameter Description
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Channel Specifies which frequency your client adapter uses as the channel for 
communications. These channels conform to the IEEE 802.11 Standard for 
your regulatory domain.

• In infrastructure mode, this parameter is set automatically and cannot 
be changed. The client adapter listens to the entire spectrum, selects the 
best access point to associate to, and uses the same frequency as that 
access point.

• In ad hoc mode, the channel of the client adapter must be set to match 
the channel used by the other clients with which you wish to 
communicate.

Range: Dependent on regulatory domain
Example: 1 to 11 (2412 to 2462 MHz) in North America

Note Refer to Appendix A for a list of channel identifiers, channel center 
frequencies, and regulatory domains for each channel.

Transmit Power Defines the level at which your client adapter transmits power. This value 
must not be higher than that allowed by your country’s regulatory agency 
(FCC in the U.S., DOC in Canada, ETSI in Europe, MKK in Japan, etc.). 
When World Mode is enabled, only the transmit power levels supported by 
the country of operation’s regulatory agency are available.

Range: 1, 5, 15, 20, 30, 50, or 100 mW (30 mW is the maximum power 
level supported by 340 series client adapters)

Default: The minimum level allowed by your country’s regulatory agency

Note 15 mW is supported by 340 series client adapters only, and 20 mW 
is supported by 350 series client adapters only.

Note Reducing the transmit power level conserves battery power but 
decreases radio range.

Short Preamble Specifies if your client adapter uses short radio headers. However, the 
adapter can use short radio headers only if the access point is also 
configured to support them. Short radio headers improve throughput 
performance; long radio headers ensure compatibility with clients and 
access points that do not support short radio headers.

Default: On

Short Preamble Description

Off Prevents short radio headers from being used during 
transmissions

On Allows short radio headers to be used during 
transmissions

Table 5-4 RF Network Parameters (continued)

Parameter Description
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Click Apply at the bottom of the RF Network Parameters screen to save any changes you have made.

World Mode Selecting this check box enables the client adapter to assume the legal 
transmit power level and channel set of the access point to which it is 
associated. This parameter is available only in infrastructure mode and is 
designed for users who travel between countries because it allows the 
adapter to be used in different regulatory domains.

Default: Deselected

Note When World Mode is enabled, only the transmit power levels 
supported by the country of operation’s regulatory agency are 
available.

Enable LEAP Enables or disables LEAP for your client adapter.

If you want to enable LEAP for your client adapter, you must select this 
check box and set a username and password. Refer to the “LEAP” section 
on page 4-17 for more information about LEAP and instructions on setting 
a LEAP username and password.

Note This check box can also be used to disable or enable LEAP after it 
is enabled.

Default: Deselected

Enable WEP Enables or disables WEP for your client adapter.

• If you want to enable WEP for your client adapter, you must select this 
check box and create a WEP key. Refer to the Chapter 4, “Security 
Features” for more information on WEP and instructions on setting a 
WEP key.

• If you enable LEAP for your client adapter, this check box is selected 
automatically.

Default: Deselected

Allow Association To 
Mixed Cells

If your network’s access points are set to communicate with either 
WEP-enabled or WEP-disabled clients (that is, if the Use of Data 
Encryption by Stations parameter on the AP Radio Data Encryption screen 
is set to Optional), you must select this check box, even if your client 
adapter is not using WEP. If this setting is not enabled, your client adapter 
cannot establish a connection with the access point.

Default: Deselected

Note For security reasons, Cisco recommends that both WEP-enabled and 
WEP-disabled clients not be allowed in the same cell because 
broadcast packets will be sent unencrypted, even to clients running 
WEP.

Table 5-4 RF Network Parameters (continued)

Parameter Description
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Setting Advanced Infrastructure Parameters

Note You can set advanced infrastructure parameters only if your client adapter has been set to operate in an 
infrastructure network. See the Network Type parameter in the “Setting System Parameters” section on 
page 5-8.

The Advanced screen (see Figure 5-8) allows you to set parameters that control how the client adapter 
operates within an infrastructure network. To access this screen, select Edit Properties from the File 
pull-down menu (see Figure 5-5 on page 5-8) and click the Advanced tab.

Figure 5-8 Advanced Screen

Table 5-5 lists and describes the client adapter’s advanced infrastructure parameters. Follow the 
instructions in the table to initially set or change any parameters.
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Table 5-5 Advanced (Infrastructure) Parameters

Parameter Description

Transmit Antenna Mode Specifies the antenna that your client adapter uses to transmit data.

• PC card—The PC card’s integrated, permanently attached antenna 
operates best when used in Antennas 1 and 2 mode (also referred 
to as diversity mode). Diversity mode allows the card to use the 
better signal from its two antenna ports.

Range: Antenna 1 Only, Antenna 2 Only, Antennas 1 and 2

Default: Antennas 1 and 2

• LM card—The LM card is shipped without an antenna; however, 
an antenna can be connected through the card’s external 
connector. If a snap-on antenna is used, diversity mode is 
recommended. Otherwise, select the mode that corresponds to the 
antenna port to which the antenna is connected.

Range: Antenna 1 Only, Antenna 2 Only, Antennas 1 and 2

Default: Antennas 1 and 2

• PCI client adapter—The PCI client adapter must use the Antenna 
1 Only option.

Default: Antenna 1 Only

Receive Antenna Mode Specifies the antenna that your client adapter uses to receive data. See 
the Transmit Antenna Mode parameter above for information on the 
options available for your client adapter.

Specified Access Point 1- 4 Specifies the MAC addresses of up to four preferred access points to 
which you want to associate. If the specified access points are not 
found or you roam out of range, you may associate to another access 
point.

You can enter the MAC addresses of the access points in the edit boxes 
or choose not to specify access points by leaving the boxes blank.

Default: No access points specified

Note This parameter should be used only for access points that are 
in repeater mode. For normal operation, these fields should be 
left blank because specifying an access point slows down the 
roaming process.
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Click Apply at the bottom of the Advanced screen to save any changes you have made.

RTS Threshold Specifies the size of the data packet that the low-level RF protocol 
issues to a request-to-send (RTS) packet.

Setting this parameter to a small value causes RTS packets to be sent 
more often. When this occurs, more of the available bandwidth is 
consumed and the throughput of other network packets is reduced, but 
the system is able to recover faster from interference or collisions, 
which may be caused from a high multipath environment characterized 
by obstructions or metallic surfaces.

Range: 0 to 2312

Default: 2312

Note Refer to the IEEE 802.11 Standard for more information on the 
RTS/CTS mechanism.

RTS Retry Limit Specifies the number of times the client adapter resends a 
request-to-send (RTS) packet if it does not receive a clear-to-send 
(CTS) packet from the previously sent RTS packet. You can type a 
number in the edit box to change this value.

Setting this parameter to a large value decreases the available 
bandwidth whenever interference is encountered but makes the system 
more immune to interference and collisions, which may be caused 
from a high multipath environment characterized by obstructions or 
metallic surfaces.

Range: 1 to 128

Default: 16

Note Refer to the IEEE 802.11 Standard for more information on the 
RTS/CTS mechanism.

Table 5-5 Advanced (Infrastructure) Parameters (continued)

Parameter Description
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Setting Advanced Ad Hoc Parameters

Note You can set advanced ad hoc parameters only if your client adapter has been set to operate in an ad hoc 
network. See the Network Type parameter in the “Setting System Parameters” section on page 5-8.

The Advanced screen (see Figure 5-9) enables you to set parameters that control how the client adapter 
operates within an ad hoc network. To access this screen, select Edit Properties from the File pull-down 
menu (see Figure 5-5 on page 5-8) and click the Advanced tab.

Figure 5-9 Advanced Screen

Table 5-6 lists and describes the client adapter’s advanced ad hoc parameters. Follow the instructions in 
the table to initially set or change any parameters.
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Table 5-6 Advanced (Ad Hoc) Parameters

Parameter Description

Transmit Antenna Mode Specifies the antenna that your client adapter uses to transmit data.

• PC card—The PC card’s integrated, permanently attached 
antenna operates best when used in Antennas 1 and 2 mode (also 
referred to as diversity mode). Diversity mode allows the card to 
use the better signal from its two antenna ports.

Range: Antenna 1 Only, Antenna 2 Only, Antennas 1 and 2

Default: Antennas 1 and 2

• LM card—The LM card is shipped without an antenna; however, 
an antenna can be connected through the card’s external 
connector. If a snap-on antenna is used, diversity mode is 
recommended. Otherwise, select the mode that corresponds to the 
antenna port to which the antenna is connected.

Range: Antenna 1 Only, Antenna 2 Only, Antennas 1 and 2

Default: Antennas 1 and 2

• PCI client adapter—The PCI client adapter must use the Antenna 
1 Only option.

Default: Antenna 1 Only

Receive Antenna Mode Specifies the antenna that your client adapter uses to receive data. See 
the Transmit Antenna Mode parameter above for information on the 
options available for your client adapter.

Specified Access Point 1- 4 These parameters are not available in ad-hoc mode.

RTS Threshold Specifies the size of the data packet that the low-level RF protocol 
issues to a request-to-send (RTS) packet.

Setting this parameter to a small value causes RTS packets to be sent 
more often. When this occurs, more of the available bandwidth is 
consumed and the throughput of other network packets is reduced, but 
the system is able to recover faster from interference or collisions, 
which may be caused from a high multipath environment 
characterized by obstructions or metallic surfaces.

Range: 0 to 2312

Default: 2312

Note Refer to the IEEE 802.11 Standard for more information on 
the RTS/CTS mechanism.
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Click Apply at the bottom of the Advanced screen to save any changes you have made.

RTS Retry Limit Specifies the number of times the client adapter resends a 
request-to-send (RTS) packet if it does not receive a clear-to-send 
(CTS) packet from the previously sent RTS packet.

Setting this parameter to a large value decreases the available 
bandwidth whenever interference is encountered but makes the system 
more immune to interference and collisions, which may be caused 
from a high multipath environment characterized by obstructions or 
metallic surfaces.

Range: 1 to 128

Default: 16

Note Refer to the IEEE 802.11 Standard for more information on 
the RTS/CTS mechanism.

Beacon Period (Kμs) Specifies the duration between beacon packets, which are used to help 
clients find each other in ad hoc mode.

Range: 20 to 976 Kμs

Default: 100 Kμs

Note Kμs is a unit of measurement in software terms. K = 1024,
μ = 10-6, and s = seconds, so Kμs = .001024 seconds, 1.024 
milliseconds, or 1024 microseconds.

Wake Duration (Kμs) Specifies the amount of time following a beacon that the client adapter 
stays awake to receive announcement traffic indication message 
(ATIM) packets, which are sent to the adapter to keep it awake until 
the next beacon.

This parameter is used only in Power Save Mode (Max PSP or Fast 
PSP). Refer to the Power Save Mode parameter in the “Setting System 
Parameters” section on page 5-8.

Range: 5 to 60 Kμs

Default: 5 Kμs

Table 5-6 Advanced (Ad Hoc) Parameters (continued)

Parameter Description
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Setting Home Networking Parameters
The parameters in this section can be used to configure your client adapter for use in a home 
(non-enterprise) network. If you are planning to use your client adapter in an enterprise network, go to 
the “Setting Enterprise Parameters” section on page 5-8.

The Home Networking screen (see Figure 5-10) enables you to set parameters that prepare the client 
adapter to operate in a home network. To access this screen, select Edit Properties from the File 
pull-down menu (see Figure 5-5 on page 5-8) and click the Home Networking tab.

Figure 5-10 Home Networking Screen

Table 5-7 lists and describes the client adapter’s home networking parameters. Follow the instructions 
in the table to initially set or change any parameters.

Table 5-7 Home Networking Parameters

Parameter Description

Home Computer Name The client name for the home network. It is a logical name for your 
workstation. It allows you to determine which devices are connected to the 
base station (the home equivalent of an access point) without having to 
memorize every MAC address. This name is included in the base station’s 
list of connected devices.

Range: Up to 16 characters

Note Each computer on the home network must have a unique computer 
name.

Home Radio Network 
Name

The service set identifier (SSID) for the home network. It allows you to 
access the home network.

Range: Up to 32 characters (case sensitive)

Note Only one SSID can be set in a home network, and each device on 
the network must use the same SSID.
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Encryption Key Input 
Type

Specifies whether the WEP key is entered in hexadecimal characters or 
ASCII text.

Default: Hexadecimal

Encryption Key 
Input Type

Description

Hexadecimal Specifies that the WEP key be entered in 
hexadecimal characters, which include 0-9, A-F, and 
a-f.

Example:ADC423BE04

ASCII Text Specifies that the WEP key be entered in ASCII text, 
which includes alpha characters, numbers, and 
punctuation marks.

Example:ZZ18YXPRA3

Home Encryption Key The WEP key for the home network. Refer to the Chapter 4, “Security 
Features” for information on WEP keys.

Range: Up to 13 characters (case sensitive in ASCII format)

Note Only one WEP key can be set in a home network, and each device 
on the network must use the same key.

Enable LEAP for Home 
Network

Enables or disables LEAP for your client adapter.

If you want to enable LEAP for your client adapter, you must select this 
check box and set a username and password. Refer to Chapter 4, “Security 
Features” for more information about LEAP and instructions on setting a 
LEAP username and password.

Note This check box can also be used to disable or enable LEAP after it 
is enabled.

Default: Deselected

Enable WEP for Home 
Network

Enables or disables WEP for your client adapter.

• If you want to enable WEP for your client adapter, you must select this 
check box and create a WEP key. Refer to the Chapter 4, “Security 
Features” for more information on WEP and instructions on setting a 
WEP key.

Note This check box can also be used to disable or enable WEP after it is 
enabled.

• If you enable LEAP for your client adapter, this check box is selected 
automatically.

Default: Deselected

Note 40-bit client adapters cannot be used with the Cisco Aironet 340 
Series Base Station.

Table 5-7 Home Networking Parameters (continued)

Parameter Description
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Home Network Type Specifies the type of network in which your client adapter is installed.

Default: Infrastructure

Home Network Type Description

Ad Hoc Also referred to as peer to peer. Used to set up a 
small network between two or more devices. For 
example, a network without a base station could be 
set up between computers in a room so information 
can be shared.

Infrastructure Used to set up a connection to a wired Ethernet 
network (through a base station).

Home Data Rate Specifies the rate at which you want your client adapter to transmit or 
receive packets to or from other devices on the home network. 

The data rate must be auto or the same as the wireless device with which 
you wish to communicate.

Default: Auto

Home Data Rate Description

Auto Uses the 11-Mbps data rate when possible but drops 
to lower rates when necessary.

1 Mbps Offers the greatest range but the lowest throughput.

2 Mbps Offers less range but greater throughput than the
1 Mbps Only option.

5.5 Mbps Offers less range but greater throughput than the
2 Mbps Only option.

11 Mbps Offers the greatest throughput but the lowest range.

Table 5-7 Home Networking Parameters (continued)

Parameter Description
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Click Apply at the bottom of the Home Networking screen to save any changes you have made.

Go to the “Specifying a Home Network Configuration” section below for instructions on activating a 
home network configuration.

Home Authentication 
Type

Defines how your client adapter attempts to authenticate to a base station.

If LEAP is enabled on your client adapter, Open is the only available 
option.

The Shared Key option is available only if the client adapter is assigned a 
WEP key and WEP is enabled. For additional information, refer to the 
Chapter 4, “Security Features.”

Default: Open

Authentication Description

Open Allows your client adapter, regardless of its WEP 
settings, to authenticate and attempt to communicate 
with a base station.

Shared Key Allows your client adapter to communicate only with 
base stations that have the same WEP keys.

The base station sends a known unencrypted 
“challenge packet” to the client adapter, which 
encrypts the packet and sends it back to the base 
station. The base station attempts to decrypt the 
encrypted packet and sends an authentication 
response packet indicating the success or failure of 
the decryption back to the client adapter.

Home Channel Specifies which frequency your client adapter uses as the channel for 
communications. These channels conform to the IEEE 802.11 Standard for 
your regulatory domain.

• If your home network uses a base station, this parameter does not 
appear because it is set automatically and cannot be changed. The client 
adapter uses the same frequency as the base station.

• If your home network does not use a base station, the channel of the 
client adapter must be set to match the channel used by the other clients 
with which you wish to communicate.

Range: Dependent on regulatory domain
Example: 1 to 11 (2412 to 2462 MHz) in North America

Note Refer to Appendix A for a list of channel identifiers, channel center 
frequencies, and regulatory domains for each channel.

Table 5-7 Home Networking Parameters (continued)

Parameter Description
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Specifying a Home Network Configuration

After you have set the parameters to prepare your client adapter for use in a home network, you must 
specify a home network configuration. To do so, follow the instructions below.

Step 1 Select Edit Properties from the File pull-down menu (see Figure 5-5 on page 5-8) and click the System 
Parameters tab. The System Parameters screen appears (see Figure 5-6 on page 5-8).

Step 2 Select Home Network under Network.

Step 3 Click Apply to save this setting.

Turning Your Client Adapter Radio On or Off
Your client adapter radio can be turned on or off. Turning the radio off prevents the adapter from 
transmitting RF energy. You might want to turn off the client adapter radio when you are not transmitting 
data and want to conserve battery power or when you are using a laptop on an airplane and want to 
prevent the adapter’s transmissions from potentially interfering with electronic devices.

If the radio is not turned off, it periodically sends out inquiry packets even if it is not associated to an 
access point, as required by the 802.11 specification. Therefore, it is important to turn it off around 
devices that are susceptible to RF interference.

Note Your client adapter is not associated while the radio is off.

Follow the steps below to turn the client adapter radio on or off.

Step 1 If your client adapter radio is on, select Radio Off from the File pull-down menu (see Figure 5-11) or 
click the Turn Radio Off button on the Basic Properties screen (see Figure 5-12) to turn the radio off.

Step 2 If your client adapter radio is off, select Radio On from the File pull-down menu or click the Turn Radio 
On button on the Basic Properties screen to turn the radio on.

Figure 5-11 File Pull-Down Menu
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Figure 5-12 Basic Properties Screen

Obtaining System Address and Software Version Information
To obtain information on system addresses and versions of software, select Get Info from the File 
pull-down menu (see Figure 5-11 on page 5-26). The Info screen (see Figure 5-13) appears.

Figure 5-13 Info Screen

The top of the screen displays the IP address and MAC address of your computer, the IP address of your 
network’s router, and the IP address of the access point. The bottom of the screen displays the version 
of the open transport software that is used with the driver, the version of the driver, and the version of 
the pcm3x0PPC client utility.

You can also determine the pcm3x0PPC version by selecting the apple icon (see Figure 5-14) from the 
menu bar and clicking About pcm3x0PPC.
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Figure 5-14 Apple Pull-Down Menu

The About pcm3x0PPC screen appears (see Figure 5-15).

Figure 5-15 About pcm3x0PPC Screen
5-28
Cisco Aironet Wireless LAN Client Adapters Installation and Configuration Guide for Mac OS

OL-1377-02


	Advanced Configuration on Mac OS 9.x
	Using the Client Utility on Mac OS 9.x
	Getting Started
	Loading New Firmware
	Configuring Your Client Adapter
	Setting Enterprise Parameters
	Setting System Parameters
	Setting RF Network Parameters
	Setting Advanced Infrastructure Parameters
	Setting Advanced Ad Hoc Parameters

	Setting Home Networking Parameters
	Specifying a Home Network Configuration


	Turning Your Client Adapter Radio On or Off
	Obtaining System Address and Software Version Information



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


